Menus and Mnemonics in Airway Facilities

Vicki Ahlstrom, ACB-220
Robert Muldoon, Northrop Grumman Information Technology

April 2003
DOT/FAA/CT-TN03/12

Document is available to the public through the National Technical Information Service, Springfield, Virginia 22161

U.S. Department of Transportation
Federal Aviation Administration
William J. Hughes Technical Center
Atlantic City International Airport, NJ 08405
NOTICE

This document is disseminated under the sponsorship of the U.S. Department of Transportation in the interest of information exchange. The United States Government assumes no liability for the contents or use thereof.

The United States Government does not endorse products or manufacturers. Trade or manufacturers’ names appear herein solely because they are considered essential to the objective of this report.
This study examines the use of menus and mnemonics in current Airway Facilities (AF) systems and compares them to human factors guidelines and best practices. Researchers from the William J. Hughes Technical Center traveled to AF field sites and collected data on the menus and mnemonics for the systems in use. The researchers extracted human factors guidance on menus and mnemonics from the literature and surveyed current commercial software. Using this information, they identified commercial standards for menu structure, terminology, mnemonics, options, and organization. They compared current AF systems against this information and developed recommendations for the design of future systems.
Acknowledgments

The Office of the Chief Scientific and Technical Advisor for Human Factors, AAR-100, sponsored this work. The authors would like to thank Paul Krois and Dino Piccione from AAR-100 and Beverly Clark from AOP-30 whose valuable input made this effort possible. We would also like to thank the Airway Facilities personnel from the sites we visited who lent their expertise to this effort and allowed us to observe systems in use.
Table of Contents

1. Introduction..................................................................................................................................1
   1.1 Background ............................................................................................................................1
   1.2 Purpose ...................................................................................................................................2

2. Method .........................................................................................................................................2
   2.1 Sites........................................................................................................................................2
   2.2 Procedure ...............................................................................................................................2
   2.3 Data Collection .......................................................................................................................3
   2.4 Data Analysis ........................................................................................................................3

3. Results..........................................................................................................................................3
   3.1.1 Comparison of AF Menus with Human Factors Guidelines ........................................3
   3.2 Menus.....................................................................................................................................5
      3.2.1 De Facto Menu Standards ............................................................................................7
      3.2.2 Systems with Options ................................................................................................10
   3.3 Mnemonics...........................................................................................................................11
      3.3.1 Human Factors Recommendations for Mnemonics ...................................................12

4. Conclusions................................................................................................................................15
   4.1 Consistent Menu Structure...................................................................................................15
   4.2 Consistent Mnemonics .........................................................................................................16
   4.3 Consistent Organization .......................................................................................................16
   4.4 Consistent Terminology .......................................................................................................16
   4.5 Consistent Menu Function ...................................................................................................16

References......................................................................................................................................17
Acronyms .......................................................................................................................................18

Appendix A - Menus, Submenus, and Mnemonics for AF Systems
## List of Illustrations

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1. Menu elements with mnemonics underlined.</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1. Means of Interacting With Systems at AF Operational Sites</td>
<td>4</td>
</tr>
<tr>
<td>Table 2. Menu Items</td>
<td>9</td>
</tr>
<tr>
<td>Table 3. Options Associated With File Menu</td>
<td>10</td>
</tr>
<tr>
<td>Table 4. Options Associated With Edit Menu</td>
<td>11</td>
</tr>
</tbody>
</table>
Executive Summary

This study is part of a larger effort toward standardization of computer-human interfaces for Airway Facilities (AF) systems. Previous studies have investigated the use of visual symbols (Ahlstrom & Muldoon, 2002) and the use of shortcut keys and function keys (Ahlstrom & Muldoon, 2003). This study originally was intended to examine mnemonics alone, but, because of the interdependency between menus and mnemonics, it was expanded to include menus.

This document catalogs the menus and mnemonics currently used in AF systems and compares this baseline against current conventions and human factors guidelines. It also provides human factors guidance for menus and mnemonics and offers recommendations toward standardization.

A research team from the William J. Hughes Technical Center Research Development and Human Factors Laboratory examined computer-based instruction manuals and visited 12 AF field sites to examine the use of menus and mnemonics in current AF systems. They identified commonalities across systems. They also identified and captured the menus, associated mnemonics, submenus, and associated functions for AF systems at the 12 sites. They compiled data on commercial conventions in the assignment menu structures by conducting an informal survey of computer software programs and by consulting computer experts and system documentation. The team extracted human factors best practices from the literature and from human factors guidelines (Ahlstrom & Longo, 2001) and compared them to the data collected on AF menus and mnemonics.

The researchers cataloged the different menus and mnemonics used by AF systems, paying attention to structure, function, and terminology. They compared them for overall consistency with one another, with human factors guidelines, and with commercial conventions on menus and mnemonics established by commercially available software.

The researchers found that out of 25 systems identified, 14 used menus as a means of interacting with the system. This means that menus are a significant means of system interaction in the AF environment. Consequently, human factors improvements in future menus can have a significantly positive effect on AF system users.

Although each system has some unique commands, researchers identified commonalities across systems for the commands found in the menus. In an effort to achieve consistency across systems, the researchers recommend that menus and mnemonics follow the human factors recommendations provided in this document. They have identified areas that may help to improve consistency among AF system menus and mnemonics. These areas include consistent mnemonics, menu structure, menu organization, terminology, and menu function. This document contains specific information on how to achieve consistency in these areas.
1. Introduction

This study is part of a larger effort toward standardization of Computer-Human Interfaces (CHIs) for Airway Facilities (AF) systems. Previous studies have investigated the use of visual symbols (Ahlstrom & Muldoon, 2002) and the use of shortcut keys and function keys (Ahlstrom & Muldoon, 2003). This study originally was intended to look at mnemonics alone, but, because of the interdependency between menus and mnemonics, it was expanded to include menus. This report will focus on basic menu structures, including mnemonics, the menu bar, the pull-down menu, and the associated hierarchical or cascading menus.

1.1 Background

A menu is a list of options from which a user makes a selection or selections. A mnemonic is a single alphanumeric that a user can type together with a modifier key (usually Alt) to select a visible option from a menu. Menus can come in many different forms: pull-down, pop-up, tear-off, toggled, and graphic menus.

Mnemonics are menu dependent and are usually indicated by an underlined letter. For example, File indicates that by simultaneously pressing Alt and F, the File menu is activated. Mnemonics differ from shortcut keys and function keys because they are visible in the menu; the user only needs to see the information displayed in the menu to use the mnemonics (as opposed to learning and recalling their meanings). Mnemonics are similar to function keys and shortcut keys in that they provide an alternate, redundant means of interfacing with the computer, allowing the user to access menu options through the keyboard instead of a pointing device (e.g., mouse).

Using menus is one way of interacting with computer systems. With menu interaction, users select items from a list using a pointing device, using a keyboard alphanumeric character together with a modifier key (usually the Alt key), or using the keyboard arrow keys.

Because the options are visible to the user in a menu, there is no need to learn and memorize commands. Instead, the user simply must recognize the correct option from those presented. Additionally, the risk from data entry of the wrong command is minimized. Compared to command line entry, the number of keystrokes is minimized, thereby increasing efficiency. Because of these advantages, if menus are well designed, menu interaction is easy for even novice users. The disadvantages of menu interaction are that it requires screen space, is less flexible than command line entry, and can slow down expert users (this disadvantage can be overcome to some extent by providing shortcut keys) (Shneiderman, 1991).

Standardization of menus can reduce search time (Helander, 1988). Standardization of terminology used in menus allows users to match terms present in the menu with expected terms for that action. For example, if the user expects the menu command Copy, search time is increased if the command Duplicate, is used instead (Helander, 1988; Teitelbaum & Granda, 1983).

Menus are organized into hierarchical structures. At the highest level of the hierarchy, the categories on the menu bar tend to be organized into broad categories. When searching for a particular action, the users make judgments on where an option is located based on the high-level categories present in the menu bar. Standardization of the organization of options under particular categories can reduce search time by reducing uncertainty of option location. For example, if Cut is always located in the Edit menu, the user knows in advance where to find that
option and does not need to search through other menu categories to find the Cut option. This can be especially beneficial if the user switches between systems or if the system is not used frequently.

Standardization of menus should also take into account the common usage of menus and menu components by commercial applications. In this computer age, many families have a personal computer at home or access to one at work or school. As people interact with these personal computers, they learn to associate certain meanings with function keys and shortcut keys. By taking these de facto standards into account, it is possible to maximize positive transfer of knowledge, allowing the users to apply previously learned knowledge to the new situation. It also minimizes negative transfer, which is when previous learning conflicts with a new situation.

1.2 Purpose

This document catalogs the menus and mnemonics used in AF systems and compares them against current conventions and human factors guidelines. It also provides human factors guidance for menus and mnemonics and offers recommendations toward standardization.

2. Method

Within AF, there are several different working environments, including Systems Operation Centers (SOCs) at en route and terminal facilities and Operations Control Centers (OCCs). Facilities across the regions vary to some extent in the systems that are present in the facility. There is no single AF site that could be classified as typical. Thus, in order to maximize the applicability of the results by capturing some of the diversity in AF environments, we have targeted sites from six of the nine regions.

2.1 Sites

Researchers targeted 12 sites for their location and diversity and for their ability to visit more than one type of facility per location (e.g., SOC and an OCC in one city). These sites are Chicago Terminal Radar Approach Control Facility (TRACON) and Air Route Traffic Control Center (ARTCC); Seattle TRACON and ARTCC; Atlanta OCC, TRACON, and ARTCC; Dallas Fort Worth TRACON and ARTCC; and San Diego TRACON, ARTCC, and OCC. Visits to these sites were contingent on the time and staffing constraints inherent to any busy operation and on approval by union and management.

2.2 Procedure

At each site, a researcher met the Points-of-Contact (POCs) and thanked them for their time. The researcher then explained the purpose of the study.

The POCs and others available and interested in participating in this study received a brief written description explaining its purpose and containing project contact information. Other pertinent coordination information was available upon request, including the names of management and union personnel with whom they coordinated prior to the study. The researcher distributed a written statement of confidentiality and asked study participants to sign it. They assured the participants that they would keep any responses to questions confidential and identify data only by participant number.

At each site, the researchers spent time observing interaction with each system. They observed the systems that were in use and whether the primary method of interaction was through command line interaction, function keys or shortcut keys, or a graphical user interface. At each
site, a researcher paired up with an individual AF specialist and went through a single system in detail. They determined the system that they examined based on systems with which the research team already had data and systems about which the specialist felt most knowledgeable. The AF specialist went through each menu and submenu, allowing the researcher to document the structure and available options. As the specialist went through the menus, the researcher asked for clarification on the meaning of each option. The researcher asked the specialist to activate the menu items not only though use of the pointing device, but also by the keyboard where mnemonics were present. As the specialist activated the options, the researcher took notes. When time was available, the researchers asked specialists to verify information gathered at previous locations.

2.3 Data Collection

To minimize the time needed for data collection at each site visit, researchers used computer-based instruction manuals and available software documentation to gather information on command conventions and command interaction for each system prior to conducting the site visits. The researchers verified and expanded upon this information at the site visits.

2.4 Data Analysis

Following the site visits, the research team identified which systems used menus as a means of interacting. The researchers evaluated the use of menus and mnemonics against current human factors guidance, using information from the Human Factors Design Guide (Ahlstrom & Longo, 2001; Federal Aviation Administration [FAA], 1996) as the primary reference source. They also surveyed commonly available commercial software to identify de facto standards in commercial products. They then compared menus and mnemonics in AF systems to the de facto standards from common commercial products.

3. Results

Based on observation and information provided by the users at the field sites visited, Table 1 lists 25 systems evaluated and the primary and secondary means of system interaction.

3.1.1 Comparison of AF Menus with Human Factors Guidelines

This section contains human factors guidelines (italicized) pertaining to menus from the FAA’s Human Factors Design Guide Update: A Revision to Chapter 8 (Ahlstrom & Longo, 2001). Following these guidelines will help promote consistency in the use of menus for future systems. This section also discusses the negative results if the guidelines are not used.

*Limit the number of submenus through which the user must navigate to accomplish the desired action.*

Reducing the number of menus could be accomplished through increasing the number of items per menu as long as the number of items does not exceed human factors recommendations specified separately. Breadth is usually preferable to depth. Breadth is the number of options per level, and depth is the number of levels through which a user must navigate. Menu systems with more depth can lead to navigation problems. Greater depth in menus can lead to increased errors and increased time to accomplish a desired action. An increased depth means that there are more subsequent menus following the initial menu. For each additional menu, the user had to make decisions (Which menu item should be chosen?). Each of these decision points comes with an opportunity to make the wrong decision and commit an error. Each decision then results
Table 1. Means of Interacting With Systems at AF Operational Sites

<table>
<thead>
<tr>
<th>System</th>
<th>Primary Access</th>
<th>Secondary Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated Radar Terminal System (ARTS)</td>
<td>Pull-down menus with mouse</td>
<td>Command line</td>
</tr>
<tr>
<td>Codex</td>
<td>Unique three-button mouse, Icons</td>
<td>Dedicated Function keys from unique keyboard</td>
</tr>
<tr>
<td>Center TRACON Automation System (CTAS)</td>
<td>Pull-down menus with mouse</td>
<td>Keyboard</td>
</tr>
<tr>
<td>Data Acquisition Subsystem Real-time Status Display (DAS/RSD)</td>
<td>Point and Click with Mouse</td>
<td>Keyboard</td>
</tr>
<tr>
<td>Direct Access Radar Channel (DARC)</td>
<td>Pull-down menus with mouse</td>
<td>Command line</td>
</tr>
<tr>
<td>Display System Replacement (DSR)</td>
<td>Point and click with Trackball, three button options and dedicated function keys from unique keyboard</td>
<td></td>
</tr>
<tr>
<td>Digital Voice Recording System (DVRS)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
<tr>
<td>Enhanced Traffic Management System (ETMS)</td>
<td>Pull-down menus with mouse</td>
<td>Command line</td>
</tr>
<tr>
<td>Event Manager (EM)</td>
<td>Mouse clicks and standard keyboard entries</td>
<td></td>
</tr>
<tr>
<td>Host</td>
<td>Command line</td>
<td></td>
</tr>
<tr>
<td>Host Interface Device (HID) National Airspace System (NAS) Local Area Network (LAN) (HNL)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
<tr>
<td>Host and Oceanic Computer System Replacement (HOCSR)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
<tr>
<td>Interim Monitor and Control Software (IMCS)</td>
<td>Command lines and mouse click on pictograph Icons used in conjunction</td>
<td>Function keys and Function keys with Shift as a modifier</td>
</tr>
<tr>
<td>Low Density Radio Communications Link (LDRCL)</td>
<td>Mouse point and click</td>
<td></td>
</tr>
<tr>
<td>Low Level Windshear Alert System (LLWAS)</td>
<td>Generally viewed but not interacted with</td>
<td></td>
</tr>
<tr>
<td>Maintenance Automation Software System (MASS)</td>
<td>Pull-down menus with mouse in conjunction with scrollable lists with mouse</td>
<td>Provides mnemonics, but never saw them used</td>
</tr>
<tr>
<td>Mode-S</td>
<td>Pull-down menus and clickable text Icons with mouse</td>
<td></td>
</tr>
<tr>
<td>Random Access Plan Position Indicator (RAPPI)</td>
<td>Equal use of mouse and menus and Keyboard dedicated number keys</td>
<td></td>
</tr>
<tr>
<td>Radio Communications Link (RCL)</td>
<td>Command line with 8 mouse-clickable options</td>
<td>Function Keys for the same 8 options</td>
</tr>
<tr>
<td>Rapid Deployment Voice Switch (RDVS)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
<tr>
<td>Standard Terminal Automation Replacement System (STARS)</td>
<td>Point and click on Text Icons with Mouse</td>
<td></td>
</tr>
<tr>
<td>Very High Frequency Omnidirectional Range/Tactical Air Co-located (VORTAC)</td>
<td>Command line</td>
<td></td>
</tr>
<tr>
<td>Voice Switching and Control System Maintenance Position Equipment Subsystem (VSCS [MPES])</td>
<td>Mouse clicks from pull-down menu bar</td>
<td></td>
</tr>
<tr>
<td>VSCS Training and Backup System (VTABS)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
<tr>
<td>Weather and Radar Processor (WARP)</td>
<td>Pull-down menus with mouse</td>
<td></td>
</tr>
</tbody>
</table>
in a menu selection. The mouse movement and click required to make this selection adds a
certain amount of time to the process, particularly when it is multiplied over many submenus.
On most modern systems, the time to generate the subsequent submenu after a selection is made
is negligible.

However, there are still some systems with higher processing times for which the generation of a
series of submenus can add significantly to the time necessary to accomplish a task. Overall,
being shallow is a good thing because performance and accuracy decrease inversely with menu
deepth (Kiger, 1984), although research has not made it clear what number of levels (how deep) is
optimal.

3.2 Menus

Even though a shallow menu is generally a good menu, there are some special cases when a
system should be designed to go deep. One of the most basic reasons is a lack of screen space.
Space constraints may make it physically impossible to have a broad, shallow menu. Another
reason is to insulate the user from less frequently used, more complex, or potentially destructive
menu choices. This kind of strategy can be employed if the user only interacts with part of the
system functionality. The unlikely choices are essentially hidden from the user, allowing the
interface to be simplified and minimizing the overall number of options. This results in
increased efficiency through decreased search times.

*There shall be a minimum of 3 and a maximum of 10 items on a menu bar.*

None of the AF systems have fewer than 3 items on a menu bar. The CTAS menu has 13 menu
items in the main menu, and both VSCS/MPES and DARC have 11. Although we have no
evidence that there have been problems with these systems due to number of items on the menu
bar, having too many items on a menu bar can cause crowding, potentially making it difficult for
the user to read the options provided.

*Present the menu options in mixed case with only the first letter capitalized.*

Mixed case words are often seen in tables and sometimes in labels. Adding capital letters can
interfere with quick reading, and it differs from the expected convention of only capitalizing
proper names and titles. This contributes to difficulty in comprehension. It is important to keep
in mind the size of letters and ensure legibility of the smallest letters in all cases.

*Menu categories should be distinct and well known to the user.*

Distinct categories means that there should be little overlap between the options on the menu bar.
Distinct categories make navigation clear to the user. The menu bar for one AF system
contained the category Miscellaneous. A study by Dumais and Landauer (1983) found that
performance decreased by 45% when a category in a menu bar included Miscellaneous. The
presence of vague categories such as Miscellaneous can have a significant negative impact on
performance.

*There should be a minimum of three items on a pull-down menu.*

Many of the AF systems violated this guideline. The worst violators only had one item in a
submenu, forcing the user to use two mouse clicks when only one mouse click could have
performed the same function. This can decrease the efficiency of the user and add time to the
resolution of an event. The exception to this rule is when it preserves the de facto conventions for menu structure. Thus, the additional effort to accomplish the task is necessary to maintain consistency with user expectations.

*There should be a maximum of 10 options in a pull-down menu.*

Many systems had more than 10 options in a submenu. This makes it difficult for the user to find needed information easily. When the items in a menu are presented randomly, the search time for an item increases linearly with the menu size (Helander, 1988). When a large number of choices must be present in a submenu, the items should be logically grouped and separated using a divider with items in a group logically ordered. Research has found that by alphabetizing the items on a menu, the search rate can be decreased by about half from a menu that is not alphabetized (Helander). The exception to this is when the options are phrases and the first words of the phrases are arbitrary. Another method of logically ordering the group is organizing the information categorically. Categorical organization can decrease search time for items over random organization, particularly for novice system users.

*There shall be no more than two types of options in a submenu: attributes and commands.*

The menu options should reflect what would happen when the option is selected. There shall be no more than two types of options in a submenu: attributes and commands. **Attributes** are instructions that change the characteristics of a selected item. The titles of attributes shall be adjectives or adjective phrases because these describe the specific feature of that attribute. The attribute option label should be worded to describe the changes that will occur to the selected text or object. An example of an attribute is changing text from standard to bold type. **Commands** are instructions that cause a device to perform some action. The titles of commands shall be verbs or verb phrases because they declare action. Command options should be worded as commands to the computer, not questions to the user (e.g., “Print” rather than “Would you like to print the document?”). Options, whether attributes or commands, should be tersely worded, preferably a single word.

Some menu bar items, however, such as Window, File, Table, or Toolbar would be difficult to capture as a verb or adjective. A noun better captures the meanings of such menu selections. The users’ expectations from selecting these options are that they will be able to manipulate, find information on, or perform other actions on the noun that is the menu selection. Choosing these noun menu items inevitably leads to additional menu choices that have attributes or commands in them. Thus, they are generally more appropriate for menu bar use than for submenu use.

*The word used as options in a menu should be descriptive and make sense to the user.*

There were many cryptic options in AF system menus. The DARC menus, which use menu options such as C Para and E Para, force the user to learn and recall these unique identifiers. When designing future menus, care should be taken to ensure that the menu options make sense to the users. Although, over time, specialists may have learned the meanings of many menu options, every effort should be made to make the menu options understandable to even novice users.

*Menus should provide feedback to the user on which options in the menu are selectable.*

The unavailable options should fade or “gray-out.” The menu should provide the user with feedback on which option is currently under the pointer, the item, and which option has been selected. This feedback can often take the form of highlighting or reverse video, providing legibility remains intact.
Menu options should function consistently across the menu bar with only pull-down menus available on the main menu bar.

The menu for some systems did not function consistently across the menu bar. This can surprise users by violating their expectations on how the menu should work and what they expect to happen when they chose that option. Some of the menu items on the Logical Unit Status screen on the VSCS/MPES activated pull-down menus, whereas other options acted differently (Connect, Switchover, Verify, and Determination). The option Connect activated a pull-down menu on the main screen, but the same word, Connect, also was used to initiate a new screen with a secondary screen of the same system.

On the DARC menu, the Exit and About menu items are present on the main menu bar but are not pull-down menu items. Instead, the Exit option causes the program to exit, and the About option provides information about the program. Usually, it is good practice to hide potentially destructive options such as Exit in a submenu to make it more difficult for the user to activate that option accidentally. In addition, due to familiarity effects with common computer usage of these items, users generally expect the Exit option to be found in the File menu. To be consistent with user expectations, provide a File menu option on the menu bar and place the Exit function as a submenu of the File menu. Users familiar with conventions in commercial application would expect to find general/generic system software information often accessed through an option entitled “About ___” (fill in the blank with the appropriate system name) in the submenu of the Help menu option. The About menu item could be located as a submenu of a Help menu item (although Help is noticeably lacking as a menu item with the DARC system).

Additionally, some items presented in AF systems as submenus appear in commercial systems as pop-up menus with scrollable windows. Specifically, a pop-up with a scrollable window presents a list of different functions (e.g., statistical and algebraic transformations) that can be performed in most statistical and spreadsheet software.

3.2.1 De Facto Menu Standards

In addition to specific human factors guidance, it is important to consider de facto standards that have evolved in commercial applications for software systems. Although many believe that commercial products adhere to particular government or commercial CHI standards, in many cases, these standards do not exist. Instead, what exist are de facto standards. De facto standards are conventions of use that have come about over time. Sometimes these standards are spelled out in software documentation such as style guides, and sometimes they are not. We consider them de facto standards when their use is widespread over many different programs or systems. In looking at menus and mnemonics for the AF environment, the researchers considered de facto standards for menu organization, terminology, and mnemonics. This is especially important when creating new menus for future AF systems. Many people have home computers and have expectations about what the mnemonics should be for certain menu options, where options should appear on the menu bar and within submenus, and which names are used to perform specific functions. In fact, people often make initial eye and hand movements toward the menu item before the menu has appeared (Hornof & Kieras, 1999). Figure 1 shows some conventions that have become de facto standards for menu components.
The main system menu, according to convention, has File as the first choice on the left (where available as an option), followed directly by Edit (where available as an option), followed at some point by View, Window (where available as options), and Help as the last menu option on the right. (Note that many AF systems—DARC, HNL, VSCS/MPES, ETMS, RAPPI, RDVS, and Host—are lacking Help as a menu option.) If Edit is not available as an option, but View is, then View is often the second choice on the main menu after File. Window or Windows, if available as an option, should be located as the second to last choice on the right, next to the Help option. Note that not all systems will use all of these options, but where they are present in the main menu, they should be used consistently. Menu items that are not relevant to the application should be omitted, and other application-specific menu items can be interspersed within the menu bar as appropriate. Figure 1 shows the various menu elements including mnemonics based on de facto standards. Table 2 further describes these conventions.

There are certain items that people expect to be located in the particular submenus. For example, in the File menu, user expectations may include New, Open, Close, Save, Save As, Print, Properties, and Exit (listed vertically from top to bottom in that order). An Edit menu usually contains Undo, Cut, Copy, Paste, Clear, and Select All. Other menu items may be interspersed within any of the submenus, as appropriate to that application. As is the case with menu bars, options that are not relevant to that application or operating mode should be omitted or dimmed to indicate that they are unavailable. Other submenus are not as standardized in their contents or organization.

By taking advantage of familiarity effects that come from frequent interaction with commercial software, it is possible to decrease user uncertainty over the location of menu items, thereby reducing search time, minimizing the potential for human error, and increasing efficiency.

The choice of mnemonic for some menu items has also become somewhat standardized. File, Edit, View, Window, and Help usually have their first letter underlined. In the submenu for File, the options Print, Open, Close, and Save also usually have their first letter underlined. However, the option Exit usually has the second letter (x) underlined, and the option Print Setup usually has the u in Setup underlined.

Figure 1. Menu elements with mnemonics underlined.
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu title</td>
<td>Indicated by highlighting or box around menu title. The menu title is an option from the menu bar.</td>
</tr>
<tr>
<td>Selected command</td>
<td>Indicated by highlighting and reverse video.</td>
</tr>
<tr>
<td>Divider</td>
<td>Allows grouping of logically related items in a menu (try to limit the number of items in a group to about three).</td>
</tr>
<tr>
<td>Menu option</td>
<td>Should generally be either an <strong>attribute</strong> or a <strong>command</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Attributes</strong> are instructions that change the characteristics of a selected item. An example of an attribute is changing text from standard to bold type.</td>
</tr>
<tr>
<td></td>
<td><strong>Commands</strong> are instructions that cause a device to perform some action. No less than 3 or more than 10 should be present in the submenu. Some menu bar items, however, such as Window, File, Table, or Toolbar would be difficult to capture as a verb or adjective; the meanings of such menu selections are better captured by a noun. The users’ expectations from selecting these options are that they will be able to manipulate, find information on, or perform other actions on the noun that is the menu selection. Choosing these noun menu bar items inevitably leads to additional sub menu choices that have attributes or commands in them.</td>
</tr>
<tr>
<td>Mnemonic</td>
<td>Underlined letter in command option. Sometimes the mnemonic is a number, but a letter is preferred. The mnemonic for an option should use the same letter as the keyboard shortcut if there is one that includes a letter.</td>
</tr>
<tr>
<td>Ellipses (…)</td>
<td>Signal that if this option is selected, additional information will be requested of or provided to the user, usually in the form of another pull-down or pop-up menu.</td>
</tr>
<tr>
<td>Unavailable option</td>
<td>Should be indicated by dimming or graying out text in the menu.</td>
</tr>
<tr>
<td>Menu bar (not shown)</td>
<td>A narrow panel that displays the options available. Should have no more than 10 or less than 3.</td>
</tr>
<tr>
<td>Keyboard shortcut</td>
<td>An alternate method of accessing a menu option or command using a combination of keystrokes.</td>
</tr>
</tbody>
</table>
3.2.2 Systems with Options

The recommendation is to standardize menu options with the following elements. Applications that use data files should have a File menu option in the menu bar. This menu option should be located at the far left of the menu bar with the F underlined as a mnemonic. The function of the File menu should be to take care of documents. If the application supports the functions listed in Table 3, they should be located in the File menu and given the names listed in the first column of Table 3, preferably in that order from top to bottom. When the options listed in Table 3 are used in a menu, the associated mnemonics should be as indicated by the underlined letter in the first column of that table.

Table 3. Options Associated With File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens a new untitled file.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing file.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the active window in applications with multiple windows.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the currently active file to disk. If the document has no filename, a pop-up window for the filename and location to be saved appears before saving the document.</td>
</tr>
<tr>
<td>Save As</td>
<td>Allows the user to save the currently active file under another name. It causes a pop-up window to open, prompting the user to enter a name and designate a location for the file to be saved.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Allows the user specification of the page parameters.</td>
</tr>
<tr>
<td>Print</td>
<td>Allows the specification of print parameters and then prints out the currently active document.</td>
</tr>
<tr>
<td>Exit</td>
<td>Terminates the current application and closes all the windows associated with that program.</td>
</tr>
</tbody>
</table>

Applications that have data files associated with them and an Edit function should have the Edit function listed in the Menu bar. This menu option should be located after the File menu option with the E underlined as a mnemonic. The function of the Edit menu should be to allow users to change the contents of the document. If the applications support the functions listed in Table 4, they should be located in the Edit menu and given the names listed in the first column of Table 4. When the options listed in Table 4 are used in a menu, the associated mnemonics should be as indicated by the underlined letter used in the first column of Table 4.
### Table 4. Options Associated With Edit Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverses the effect of the last action.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes selected data from the document and places it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Makes a duplicate of the selected data and places it on the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the contents of the clipboard at the insertion point in the document.</td>
</tr>
</tbody>
</table>

All applications with menu bars should have Help as an option in the main menu bar. The Help option should be the last item on the left of the menu bar and should be activated through the mnemonic H, indicated by an underlined H. The Help menu often has the options Topics, About (application name), Using Help, and Index. The About option usually opens a dialog box containing information about that application including the name, version number, copyright message, icon, serial number, and user name.

Two other options that are commonly present on the main menu bar are the View option and the Window option. The V in the View option should be underlined to indicate that the mnemonic for this item is V, and the W in the Window option should be underlined to indicate the W as the mnemonic for that option. The View option should allow access to options that change the view of the data but do not change the data itself. Options that are often found under the View menu are Toolbar, Status Bar, Highlight, and Zoom, in that order. The Window option should be the last option on the menu bar before the Help option. It should give the user the ability to manipulate document windows. Common options are Cascade, Arrange, Tile, and Close All, in that order. The underlined letter indicates the mnemonics. If these options are present in an application, they should be contained under the main menu bar menu options, as described.

In general, AF systems followed conventions in assigning menu options to the menu bars and to submenu items under the menu bar. For example, out of 14 systems that had menu bars as a means of accessing the system, 10 (71.4%) had File as a menu item on the main menu bar. For each of these instances, File was located to the far left on the menu bar and had the F underlined as the mnemonic. The submenu items for the File submenu varied; however, the last menu item in each of the File submenus was Exit.

#### 3.3 Mnemonics

A mnemonic is a means of accessing an option in a menu (or sometimes in a dialog box) through the keyboard instead of a pointing device. The underlining of a letter in the menu option usually indicates the mnemonic. Simultaneously pressing the underlined letter and the Alt key activates the menu option. Mnemonics are different than keyboard shortcuts in that the use of shortcuts does not require the menu to be active at the time. For example, the keyboard shortcut for Cut in most word processing programs is Ctrl + X. With the shortcut, the user can Cut highlighted text simply by pressing Ctrl + X. Without the shortcut, the same action is accomplished by selecting Edit from the menu bar and then Cut from the submenu. These commands can be selected either with the pointing device or through mnemonics by pressing Alt + E to select Edit and then Alt + T to select Cut. Mnemonics allow a keyboard alternative for accessing menu items but do not
require memorization because they are visually indicated in the menu. Out of the 25 systems evaluated, 14 (57%) have menus as a means of interacting. All of these menus have mnemonics as an alternate means of interacting. Appendix A shows the main menus of the systems researched, together with their mnemonics and the associated submenus.

3.3.1 Human Factors Recommendations for Mnemonics

This section contains human factors guidelines (italicized) pertaining to mnemonics from the FAA’s Human Factors Design Guide Update: A Revision to Chapter 8 (Ahlstrom & Longo, 2001). Following these guidelines will help promote consistency in the use of menus for future systems. This section also discusses the negative results if the guidelines are not used.

The mnemonic for an option shall be underlined. Mnemonics shall be displayed as part of the menu option.

Overall, most of the AF systems did display the mnemonic for a menu item as an underlined letter of a menu option, with one exception. RDVS highlighted the letter of the mnemonic in white rather than underlining the letter, and RAPPI had only one underlined letter option (Options) along with nine single number choices for commands and attributes. This is inconsistent with the way the other AF systems indicate mnemonics and with common conventions.

When a menu has mnemonics, a user shall be able to select an option in the menu by typing its mnemonic with the Alt modifier.

All of the AF systems that used mnemonics complied with this guideline. The mnemonic for an option should be the same letter as the keyboard shortcut if there is one that includes a letter.

Mnemonics and keyboard accelerators shall not be case sensitive, with upper and lower case letters being equivalent.

The researchers did not specifically look for this type of violation, but included this information as guidance to future programs.

If an underlined lowercase letter will be used, it should be tested with representative users in environmental conditions similar to those that it will be used in to ensure that the users have no trouble seeing it.

Sometimes the underlined letter used as the mnemonic is a lowercase “i” or a lowercase “l.” This was the case for at least three AF system submenus. The size of the underline in these cases taxes the visual system because it is quite small, particularly for those users with declining visual abilities such as those associated with an aging workforce.

Letters are preferred as mnemonics because letter codes are easier to remember than numeric codes (Ahlstrom & Longo, 2001), particularly when they are used properly as part of the menu option. Letter and numeric codes should not be used as mnemonics in the same menu.

Letters as codes also have a numerical advantage over numbers (there are 26 letter keys as opposed to only 10 numbers keys accessible from the keyboard). They are easier to remember because of the association with the menu option. Numbers have the advantage of making sequencing clear. However, menu options should not be numbered except when the task sequencing is important in an application window.
RAPPI used numbers rather than letters to indicate the mnemonics in the main menu. The numbers are arbitrary and have no apparent sequencing significance. That is, the numbers are not related to steps that must be taken, and so on. Other systems have numbers as mnemonics in their submenus. RDVS has numbers associated with the Status/Recon submenu, and MASS, VSCS, and VTABS have numbers associated with options in a submenu, although none of these programs has the numbers in the main menu bar. None of the numbers in the submenus appear to have any sequencing significance.

The preferred letter for use as a mnemonic in a menu is the first letter of a command or attribute in the active menu.

However, when that letter is used as another mnemonic in the menu or associated menus, another letter, preferably the second letter, may be used. To the extent possible, the menu items and associate mnemonics, particularly in the main menu, should be consistent across systems and within screens in a system.

Each menu title and each option in a menu should have a mnemonic, and they should be unique from each other (Ahlstrom & Longo, 2002).

By providing a mnemonic, the user is given a means of activating menu items as an alternate to using the pointing device (mouse). This redundancy is important both for potentially preventing repetitive stress injuries and providing redundancy in case of hardware (mouse) failure. In HNL, one of the menu options in the main menu (Administer) has no associated mnemonic. Other systems, such as DARC, HNL, ARTS, and CTAS, have mnemonics for the main menu items but not for submenus. This provides only one means of accessing the options in the submenus (via a pointing device). Additionally, this involves transitioning from the keyboard to the mouse, which may slow the user in completing an entry over using the keyboard alone. Whether a mnemonic would be beneficial to these systems depends on how frequently the options in the submenus are accessed and how important it is to access the submenu options quickly. Items that are accessed more frequently and that may have a critical impact if there is a delay in accessing them should be considered for mnemonics.

Although it is acceptable to have the same mnemonic used for different meanings in different submenus, the use of mnemonics should be consistent within and across systems.

The command that is activated through the mnemonic is menu-dependent, with the same mnemonic often having different meanings in different menus or submenus. For example, the capital letter P along with the Alt key serves one function in the File submenu (Print) and another function in the Edit submenu (Paste) of a word processing program. This is not considered a problem in that these keystroke combinations do not need to be memorized because they are visibly present in the separate menu or submenu. Thus, the likelihood that the user will press Alt + P in the Edit submenu (the command for Paste) intending to actually Print the document (Alt + P in the File submenu) is minimized. If Alt + P is used for Print in one system, another system should not use Alt + R for the same function.

Consistency within and between systems is important. In some AF systems, the mnemonic used in one submenu for a particular option (Print setup) was different than the mnemonic chosen for the same menu option in another submenu (Print setup). The mnemonics should maintain consistency between submenus within a system as well as across systems.
The mnemonic used for the title should not be used for any of the menu or submenu items activated by that title.

This guideline is violated by many systems. For example, IMCS uses the F in File as a mnemonic but also uses the F in Receive From Host as a mnemonic in the File submenu. Therefore, the menu title (File) and menu option (Receive From Host) do not have unique mnemonics. This may create confusion for a less experienced user and could cause a problem if the user did not release the mnemonics key combination associated with File quickly enough, causing the Receive From Host option to activate. This is also true for the Macro menu option in IMCS and the Macro Editor submenu option in the Macro submenu. Other systems that violate this guideline are LDRCL, MASS, VSCS/MPES, ETMS, VTABS, and WARP.

The mnemonic key for an option shall be different from any other mnemonic key within the same menu bar.

Researchers found this basic tenet was violated in more than one AF system. On the WARP menu bar, both Overlay and Options had the letter O underlined as a mnemonic. The shortcut worked (Alt + O) for Overlay, but none of the specialists on that shift could access Options using the keyboard only. In the CTAS main menu, both Software and Scripts had the capital S underlined, indicating it could be activated using the letter S together with the Alt key. For this system, even after repeated attempts and trying different options, such as replacing the Alt with the Shift key or Ctrl key, there was no way to activate the Scripts menu using a mnemonic. Because the presence of an underlined letter itself indicates that that letter together with the Alt key will activate the menu option, this confuses the user and can lead to user error.

Each item in the menu or submenu should have a unique mnemonic that activates the menu item without the use of a pointing device.

We found a violation of this guidance in two of the CTAS submenus. One submenu has two menu options, both indicated with an underlined E. Another has three menu items, all indicated with an underlined I. Users could not know which of these options will be activated when they use Alt + the letter.

Full and abbreviated menus should have consistency in the mnemonics used.

A unique problem found with menu mnemonics is the lack of consistency between the full and abbreviated menus found in MASS. In the full menu, Alt + O activates the Operator menu, and Alt + P activates the Options menu; however, in the abbreviated menu, Alt + O activates the Options menu. This issue was unique to MASS in that we did not find other systems with full and abbreviated/reducible versions of the menus.

The mnemonic for an option should use the same letter as the keyboard shortcut if there is one that includes a letter.

The capital letter P pressed simultaneously with Ctrl will permit Print from the File menu. Here, we see the letter P as the mnemonic and the shortcut. However, CTAS, HNL, and MASS violate this rule. This can lead to confusion and cause users to avoid this means of interacting with the system.
4. Conclusions

The main goal of this study was to find ways of standardizing interaction across all the systems used in AF. Using mnemonics and pull-down menus that follow sound human factors principles can only make the combination of multiple interfaces in AF easier to understand and, by doing so, make the specialists and technicians more efficient.

The researchers found that out of 25 systems identified, 14 used menus as a means of interacting with the system. This means that menus are a significant means of system interaction in the AF environment. Consequently, human factors improvements in future menus can have a significantly positive effect on AF system users.

The research team cataloged the different menus and mnemonics used by AF systems, paying attention to the structure, function, and terminology. They compared them for overall consistency with one another, with human factors guidelines, and with commercial conventions established by commercially available software.

Although each system has some unique commands, in this document, we have identified commonalities across systems for the commands found in the menus. In an effort to achieve consistency across systems, we recommend that menus and mnemonics follow the human factors recommendations provided in this document. The following sections summarize areas that can be capitalized upon to improve consistency among AF systems menus and mnemonics.

4.1 Consistent Menu Structure

We recommend the following:

a. The number of menus that users need to navigate should be minimized, emphasizing breadth of a menu rather than depth. However, the breadth should be limited to not more than 10 items on a menu bar.

b. Submenus should contain no less than 3 or more than 10 items, organized into logical groups, using dividers, when necessary.

c. Common menu components should be used for the pull-down menus.
   - Ellipses should be used for menu items that will result in a need for additional information.
   - Dividers should be used to separate menu items into logically related groups.

d. Unavailable options should be indicated by dim, not bolded, text.

e. Menu titles should be indicated in some manner such as highlighting or boxing.

f. Selected commands should be indicated by highlighting and reverse video.

g. Menus should strive for consistency in structure within a system and across systems.

h. All menu items should be presented in mixed case, with the first letter capitalized.

i. Menu options should be commands or attributes, indicated by verbs, verb phrases, or adjectives. Nouns or noun phrases could also be used if they lead to additional menu items (e.g., File). Menu options should be concise, preferably a single word.

j. All menu items should be left justified with the associated shortcuts located right-justified across from the menu option.
4.2 Consistent Mnemonics

All frequently used or critical menu items should have mnemonics. These mnemonics should be the first letter of the term unless that letter is already being used or unless there is a commonly used mnemonic for that term. We describe the commonly used mnemonics for different terms in the body of this document.

Each option in a menu should have a unique mnemonic, different than the mnemonics of other options in the same menu and the mnemonic key in the menu bar. The mnemonic for an option should use the same letter as the keyboard shortcut if there is one that includes a letter. Numbers should not be used as mnemonics unless sequencing is important to the menu.

4.3 Consistent Organization

We recommend that the menus follow de facto standards as described in this document, where possible. For example, if the menu bar uses the options Print, Save, Exit, and Close to perform actions on files, they should be located in the File submenu in the order Close, Save, Print, and Exit.

4.4 Consistent Terminology

We recommend the following:

a. Common functions should be activated using common terminology.

b. The most common terms used across system menus for the AF systems should be examined, and their functions, along with de facto standards for different menu options, should be reserved for these particular meanings. Conversely, these meanings should be mapped to the associated terms.

c. The menu terminology should be distinct and well known to the user.

4.5 Consistent Menu Function

We recommend the following:

a. Menu options available from the main menu bar should behave consistently.

b. All options from the main menu bar of a system should activate a pull-down menu.

c. Potentially destructive commands should not be located on the main menu bar.

By striving for consistency within and between AF systems, search time can be reduced, thereby increasing efficiency, and the time to learn new systems can be reduced because of the transfer of knowledge between systems.

By using these recommendations for consistency in menus and mnemonics, standardized menus can be achieved. As discussed previously, standardized menus can decrease search time, which increases efficiency. Standardized menus can also decrease learning time by capitalizing on knowledge transfer. We have shown in this report that there are many systems that are inconsistent with each other and with de facto standard and many systems that do not follow good human factors practices in their menus and mnemonics. By following the recommendations contained in this document, we hope to avoid past inefficient practices and provide better systems in the future.
References


<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AF</td>
<td>Airway Facilities</td>
</tr>
<tr>
<td>ARTCC</td>
<td>Air Route Traffic Control Center</td>
</tr>
<tr>
<td>ARTS</td>
<td>Automated Radar Terminal System</td>
</tr>
<tr>
<td>CHI</td>
<td>Computer-Human Interface</td>
</tr>
<tr>
<td>CTAS</td>
<td>Center TRACON Automation System</td>
</tr>
<tr>
<td>DARC</td>
<td>Direct Access Radar Channel</td>
</tr>
<tr>
<td>DAS</td>
<td>Data Acquisition Subsystem</td>
</tr>
<tr>
<td>DSR</td>
<td>Display System Replacement</td>
</tr>
<tr>
<td>DVRS</td>
<td>Digital Voice Recording System</td>
</tr>
<tr>
<td>EM</td>
<td>Event Manager</td>
</tr>
<tr>
<td>ETMS</td>
<td>Enhanced Traffic Management System</td>
</tr>
<tr>
<td>FAA</td>
<td>Federal Aviation Administration</td>
</tr>
<tr>
<td>HID</td>
<td>Host Interface Device</td>
</tr>
<tr>
<td>HNL</td>
<td>HID/NAS/LAN</td>
</tr>
<tr>
<td>HOCSR</td>
<td>Host and Oceanic Computer System Replacement</td>
</tr>
<tr>
<td>IMCS</td>
<td>Interim Monitor and Control Software</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LDRCL</td>
<td>Low Density Radio Communications Link</td>
</tr>
<tr>
<td>LLWAS</td>
<td>Low level Windshear Alert System</td>
</tr>
<tr>
<td>MASS</td>
<td>Maintenance Automation Software System</td>
</tr>
<tr>
<td>MPES</td>
<td>Maintenance Position Equipment Subsystem</td>
</tr>
<tr>
<td>NAS</td>
<td>National Airspace System</td>
</tr>
<tr>
<td>OCC</td>
<td>Operations Control Center</td>
</tr>
<tr>
<td>POC</td>
<td>Point-of-Contact</td>
</tr>
<tr>
<td>RAPPI</td>
<td>Random Access Plan Position Indicator</td>
</tr>
<tr>
<td>RCL</td>
<td>Radio Communications Link</td>
</tr>
<tr>
<td>RDVS</td>
<td>Rapid Deployment Voice Switch</td>
</tr>
<tr>
<td>RSD</td>
<td>Real-time Status Display</td>
</tr>
<tr>
<td>SOC</td>
<td>Systems Operation Center</td>
</tr>
<tr>
<td>STARS</td>
<td>Standard Terminal Automation Replacement System</td>
</tr>
<tr>
<td>TRACON</td>
<td>Terminal Radar Approach Control Facility</td>
</tr>
<tr>
<td>VORTAC</td>
<td>Very High Frequency Omnidirectional Range/Tactical Air Co-located</td>
</tr>
<tr>
<td>VSCS</td>
<td>Voice Switching and Control System</td>
</tr>
<tr>
<td>VTABS</td>
<td>VSCS Training and Backup System</td>
</tr>
<tr>
<td>WARP</td>
<td>Weather and Radar Processor</td>
</tr>
</tbody>
</table>
Appendix A
Menus, Submenus, and Mnemonics for AF Systems
ARTS Disk Utility Screen

File View Control Help

File View Control Help

Exit Tool Bar Start Disk Utilities Help
Status Bar Clear Status Window What's This
Split

ARTS File Dump Screen

File View Help

File View Help

Open Tool Bar Help Topics
Print Setup Help Topics
Recent File About File Dump
Exit Status Bar
ARTS GNU Plot Screen

File  Plot  Expressions  Functions  General  Axes  Chart  Styles  3D  Help

File
- Open
- Save
- Change Directory
- Show Current Directory
- Output
- Printer Output
- Window Output
- Show Output
- Output Device
- Show Output Devices
- History
- Open DOS Window
- Run DOS Command
- Exit

Plot
- Plot
- 3D Plot
- Replot
- Clear Device
- Simple Range
- Named Range
- Data File Name
- Using X,Y Columns
- Using X,X,Y Delta Columns
- Using X,Y, yLow, yHigh Columns
- With Style
  - Lines
  - Points
  - Lines and Points
  - Impulses
  - Dots
  - Error Bars
  - Boxes
  - Box Error Bars

Expressions
- Evaluate
- Complex Numbers
- Exponentiation
- Modulo
- Equality
- Inequality
- Bitwise AND
- Bitwise Exclusive OR
- Bitwise Inclusive OR
- Logical AND
- Logical OR
- Logical OR

Previous Command
- Next Command
- Back One Character
- Forward One Character
- Beginning of the Line
- End of the Line
- Delete Previous Character
- Delete Current Character
- Delete Last Word
- Delete to EOL
- Delete Entire Line
- Redraw the Line
**Functions**

- abs
- arg
- imag
- real
- sign
- cell
- floor
- int
- sqrt
- exp
- log
- log10
- acos
- asin
- atan
- cos
- sin
- tan
- sinh
- tanh
- pi
- gamma
- besj0
- besj1
- besy0
- besy1

**Define User Functions**

**Show User Functions**

**Define User Variables**

**Show User Variables**

**X Dummy Variables**

**X,Y Dummy Variables**

**Show Dummy Variables**

**General**

- Border On
- Border Off
- Show Border
- Box Width
- Auto Box Width
- Show Line Types
- Parametric
- Clipping
- Polar
- Set Plot Size
- Show Plot Size
- Sampling Rate
- Show Sampling Rate

**Axes**

- Set Parametric
- Not Parametric
- Show Parametric
- t Range
- u Range
- x Range

- Clip near points
- Clip one point
- Clip two points
- No Clipping
- Show Clip Type

- Polar
- Not Polar
- Show Polar
- Radial Range
- Angles in Degrees
- Angles in Radians
- Show Angle Units

**Autoscale X, Y**

**No Autoscale X, Y**

**Show Autoscale X, Y**

**Logscale X, Y, Z**

**No Logscale X, Y, Z**

**Show Logscale X, Y, Z**

**X Range**

**Y Range**

**Z Range**

**X Label**

**Y Label**

**Z Label**

**Show Axis Labels**

**No X zero Axis**

**No Y zero Axis**

**X, Y zero Axis On**

**Show zero Axis Status**

**Tics**

**Tic Format String**

**Tic Marks Format**

**Inward Facing Tics** (default)

**Outward Facing Tics**

**Show Tics**

**Tics Level**

**Tic Interval**

**Tic Label Start**

**Another Tic Label**

**Tic Labels Finished**

---

**File**

**Plot**

**Expressions**

**Functions**

**General**

**Axes**

**Chart**

**Styles**

**3D**

**Help**
ARTS GNU Plot Screen (cont.)

Chart
- Grid On
- Grid Off
- Show Grid
- Add Arrows
- Remove Arrows
- Show Arrows
- Add Label
- Remove Label
- Show Label
- Set Title
- Show Title
- Key (legend) Position
- Default Key Position
- No Key
- Show Key Position
- Offsets
- Time Location
- No Time
- Show Time Location

Styles
- Data Style >
  - Show Data Style
- Function Style >
  - Show Function Style

  Lines
  - Points
  - Lines and Points
  - Dots
  - Impulses
  - Error Bars
  - Boxes
  - Box Error Bars

The continuing pull down for Function Style is the same as the pull down for Data Style

3D
- Contours
- Cartesian Mapping
- Spherical Mapping
- Cylindrical Mapping
- Show Mapping
- Hidden Line Removal
- No Hidden Line Removal
- Show Hidden Line Removal
- Display Surface Mesh
- No Surface Mesh
- Show Surface Mesh
- Set View
- Show View

Help
- Index
- Introduction
- Topic
- Windows

A-5
ARTS List Directory Screen

File  View  Help

File
Directory
Print Setup
Recent File
Exit

View
Tool Bar
Status Bar

Help
Help Topics
About List Directories
CTAS Pull down menus


Map
- Refresh
- Save As
- Print Window
- Snapshot Close
- Exit

Edit
- Selected Objects List
  - Find
  - Find By Quick Navigator
- Sub map
  - Add This Sub map
  - Add Selected Objects
- Object By Selection Name
- Object By Attribute
- Object By Comment
- Object By Status
- Object By Symbol Type
- Object By Label

View
- Highlights
  - Highlights Massage
- Select Highlighted
  - Clear Highlighted
- On For All Submaps
- Off For All Submaps

Performance
- Network Activity
- System
- Graph SNMP Data
- SNMP
- Network Polling Statistics

Error Rate
- Error Percentage

Ethernet Errors
- Ethernet Traffic

Interface Status: Overview
- Interface Errors
- Interface Traffic: Packet Rate
- TCP Connections
- Ethernet (802.3)
CTAS Pull down menus (cont.)


Configuration
- Network Configuration
  - System
  - SNMP Trap Recipients

Interface Properties
- IP Addresses
- IP Routing Table
- IP ARP Cache
- IP Services

Information
- HP-UX SAM

Fault
- Alarms
  - Network Connectivity
  - Test IP/TCP/SNMP
  - Interface Status: Overview
  - Interface Errors

Tools
- Report Presenter
- Remote Power On
- Terminal Connect
- HP Openview Launcher
- Data Warehouse
- Web Browser
- SNMP MIB Browser

Power On
- Power On and Ping

Telnet (xtem)
- Telnet (cmd tool)

Management Page
- Server Home Page

Options
- Report Configuration
- SNMP Configuration
- Event Configuration
- Data Collection and Thresholds: SNMP
-MIB Application Builder: SNMP
- Load/Unload MIBs: SNMP
- Network Polling Configuration: IP

Error Rate
Error Percentage

Pull Node
- Status Poll
- Ping
- Remote Ping
- Locate Route: via SM

Export Topology
- Export Events
- Export Trend Data
CTAS Pull down menus (cont.)


Root
Home
Parent

Software

Start
Stop
Switch Other M&C To Primary
Switch One Way/Two Way
Get Flight Counts
Set Research/Debug >
Clear All Flashing
Clear Selected Flashing
Clear Hardware Flashing
Set Audible Alarm >
Ack Audible Alarm

Enable
Disable

Scripts

Reboot Selected
Reboot All

Reboot >
Shutdown Selected
Find Cores
Uptime (All)
Disk Utilization
Shmwatch
Screen Captured (0.0)
Screen Captured (0.1)
Refresh Display

Help

Display Legend
Online Manual
Mouse and Keyboard
On Window
Using Help
NNM >
Misc. >
HP Openview On the Web
Release Notes

Overview
Task
Homepage
Patches and Updates
Release Notes
What’s New with NNM
About NNM

Tasks
Functions

Homepage
Frequently Asked Questions
Download Manuals
Patches and Updates
DARC Pull down menus


This extension of EP RTMF includes all 12 DP options, but does permit the All selection.

A-10
DARC Pull down menus (cont.)

Radar
- YR
- YS (Radar)
- ZA
- ZC
- ZE
- ZM (Radar)
- ZR
- ZS
- ZT

Channel Type
- CT Mode
- CT DP #

Auto
- MANL
- SPEC

Off
- On
- All
- Radar

Collimation Registration
- Reg. And Col.

Off
- On
- All Radar

All Off
- All On Radar

R Unit
- DP1 through DP12 in a pull down
- Online
- Unavailable

RU DCVG
- RU DP
- RU GPO
- RU GP1
- RU IOT 1
- RU IOT 2
- RU IOT 3
- RU IOT 4
- RU MSP
- RU TD1
- RU TD2
- Other RUs

SAA
- Online
- Standby
- Unavailable

SAA
- SAA
- Online
- Unavailable

Online
- Standby
- Unavailable

SAA
- Online
- Unavailable
The Exit and About options have no pull downs
**ETMS Pull down menus**

<table>
<thead>
<tr>
<th>Display</th>
<th>Maps</th>
<th>Flights</th>
<th>Alerts</th>
<th>Reroute</th>
<th>FEA/FCA</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize</td>
<td>Move/Zoom</td>
<td>Hide Flights</td>
<td>Show Alerts</td>
<td>Show Route</td>
<td>Show EEA/FCA</td>
<td>Snapshts</td>
</tr>
<tr>
<td>Showtime</td>
<td>Show Map Item</td>
<td>Hide Flight Count</td>
<td>Select Alerts</td>
<td>Select Route</td>
<td>Select EEA/FCA</td>
<td>Network Utilities</td>
</tr>
<tr>
<td>Adapt</td>
<td>Range Rings</td>
<td>Find Flight</td>
<td>Examine</td>
<td>Create Route</td>
<td>Create EEA/FCA</td>
<td>Replay</td>
</tr>
<tr>
<td>Redraw</td>
<td>Overlays</td>
<td>Customize</td>
<td>Alarms</td>
<td>Display Preferences</td>
<td>Examine EEA/FCA</td>
<td>Database Commands</td>
</tr>
<tr>
<td>Legend</td>
<td>Runway Layout</td>
<td></td>
<td>Default Time Range</td>
<td></td>
<td></td>
<td>Edit Commands</td>
</tr>
<tr>
<td>Quit</td>
<td>DME</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Command Line</td>
</tr>
<tr>
<td></td>
<td>Projection</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Report Manager</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weather</th>
<th>Reroute</th>
<th>FEA/FCA</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Weather</td>
<td>Reroute FEA/FCATools</td>
<td></td>
<td>Snapshts</td>
</tr>
<tr>
<td>Select Weather</td>
<td></td>
<td></td>
<td>Network Utilities</td>
</tr>
<tr>
<td>WX Report</td>
<td></td>
<td></td>
<td>Replay</td>
</tr>
<tr>
<td>RV R Report</td>
<td></td>
<td></td>
<td>Database Commands</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Edit Commands</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Command Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Report Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Version</td>
</tr>
</tbody>
</table>
HNL Pull down menus

**File**
- Describe Map
- Refresh Map
- Map Snapshot
- Exit

**View**
- Open
- Create
- Delete
- Describe
- Close
- Highlights
- User Plane: For This
- Sub map
- Shadow On
- Shadow Off
- Open Sub map
- Protocols
- Interfacility Traffic
- Ethernet
- TCP: Connections
- SNMP
- Traffic Errors
- Traffic Operations
- Errors
- Authentication Failures

**Options**
- Manage Objects
- Unmanage Objects
- Current Events
- Event History
- CPU Performance
- Disk Space
- Addresses
- Interfaces
- Routing Table
- ARP Cache
- Services
- LDA HID Configuration
- MCCA Status
- Interface Information
- System Information

**Monitor**
- Events
- System Activity
- Local File System and Paging Space
- Network Activity
- Network Configuration
- Device Configuration: SNMP: Event Notification
- Concentrator: Configuration Report
- HID
- MIB Values
- Reports: Site Privated

**Locate**
- Selected Objects Lists
- Objects
- Submaps
HNL Pull down menus (cont.)

Test

- IP/TCP/SNMP Connectivity
- Ping
- Remote Ping
- Locate Route: via SNMP

Tools

- Display Object Information
- Filing Resource Display
- Print
- Mail
- Security

Administer

- Start Application
- APM Map
- xx Map

Control

- SAF A1 >
- SAF A2 >
- RTR 1 >
- RTR 2 >
- CTAS >

Each of these additional pull down options is the same.

On
Off
IMCS pull down menus

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Settings</th>
<th>Dialer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive From Host</td>
<td>Copy To Clipboard</td>
<td>Communications</td>
<td>Phone Book</td>
</tr>
<tr>
<td>Send To Host</td>
<td>Copy To Printer</td>
<td>Emulations</td>
<td>Manual Dial</td>
</tr>
<tr>
<td>New</td>
<td>Paste</td>
<td>Transfer Protocol</td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>Text Select</td>
<td>User Preference</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Region Select</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td>Clear Screen</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Macro</th>
<th>Session</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro Editor</td>
<td>Hangup</td>
<td>Index</td>
</tr>
<tr>
<td>Macro Run</td>
<td>Restart Session</td>
<td>Help For Help</td>
</tr>
<tr>
<td>Macro Status</td>
<td>Turn Capture On</td>
<td>Keys Help</td>
</tr>
<tr>
<td></td>
<td>Break</td>
<td>About Outside View</td>
</tr>
</tbody>
</table>
### LDRCL pull down menus

<table>
<thead>
<tr>
<th>System</th>
<th>Filter</th>
<th>Report</th>
<th>Tools</th>
<th>Windows</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Edit/Add A Filter</td>
<td>Quick</td>
<td>Change Polling Mode From Active to Listen Only</td>
<td>Cascade</td>
<td>Index</td>
</tr>
<tr>
<td>Logout</td>
<td>Delete A Filter</td>
<td>Status</td>
<td>Log Printer On/Off</td>
<td>Arrange Icons</td>
<td>About</td>
</tr>
<tr>
<td>Config</td>
<td></td>
<td>Run</td>
<td>Reset Printer</td>
<td>Restore All</td>
<td></td>
</tr>
<tr>
<td>Restart</td>
<td></td>
<td>View</td>
<td>Set For Screen (Filter) Display</td>
<td>Close All</td>
<td></td>
</tr>
<tr>
<td>Back Door</td>
<td></td>
<td>Print</td>
<td>Set Filter Level For Log Printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Rename</td>
<td>Acknowledge Alarms</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Delete</td>
<td>Go To Highest Alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Simulator Script</td>
<td>Go To Highest Unacknowledged Alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Export</td>
<td>Push Top Window To Bottom</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Report Generation Halt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
MASS pull down menus

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Operator</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>(Show/Hide) Window Bar</td>
<td>Acknowledge</td>
<td>Quick Desktop Settings</td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td>(Show/Hide) Operator Bar</td>
<td>Mask</td>
<td>System Messages</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>(Show/Hide) Alarm List</td>
<td>Filter</td>
<td>UserID Lookup</td>
<td></td>
</tr>
<tr>
<td>Print Setup</td>
<td>(Show/Hide) Site List</td>
<td>Sort</td>
<td>Print (current window)</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>(Show/Hide) Unacknowledged List</td>
<td>Commands</td>
<td>Terminal Messages</td>
<td></td>
</tr>
<tr>
<td>Color Fonts ...</td>
<td>Monitor Subsystem 1</td>
<td>Details</td>
<td>MDS Status</td>
<td></td>
</tr>
<tr>
<td>Column (rearrange/shuffle)</td>
<td>Subsystem 2</td>
<td>User History</td>
<td>User History</td>
<td></td>
</tr>
<tr>
<td>Save Settings On Exit</td>
<td>Logoff</td>
<td>Change Password</td>
<td>Logoff</td>
<td></td>
</tr>
<tr>
<td>Save Preferences</td>
<td>Cascade</td>
<td>History Report</td>
<td>History Report</td>
<td></td>
</tr>
<tr>
<td>Open Preferences</td>
<td>File</td>
<td>About MCF</td>
<td>About MCF</td>
<td></td>
</tr>
<tr>
<td>Open Profile</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintain Profile</td>
<td>System Monitor Unack List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RTN/SC Display Duration</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear RTN/SC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the Subsystem (1 & 2) options from the ‘Windows’ pull down the same commands from the ‘Operator’ pull down are available plus the following:

- Get
- Refresh
- Assume
- Pick
MODE-S pull down menus

Alerts/Alarms  Restarts  Help

Alerts/Alarms
View
Hide
Clear

Restarts
Initialize Channel A
Initialize Channel B
Master

Help
Help
About Windows
Remote Terminal
RAPPI pull down menus

There is only one actual Accelerator key on the RAPPI pull down menu bar. Each item other than ‘Options’ changes the data presented to the right side of the main display screen. The numbers that coincide to each option can also be used to select that option.

1 – Sites displays a list of facilities M&C at this center.
2 – Status provides data for a preselected radar site.
3 – Filter presents a multi target legend (up to 14 target designations that appear in each radar site)
4 – Track presents a ‘BEACON Ident. Code Selection’ screen. Options for choosing target messages for a preselected site
5 – MULT. presents all the radar sites employed at a given facility
6 – RAPPI presents a single preselected radar site from all in use
7 – RFM shows the RFM status (the channels active for the various sites M&C’d)
8 – Range Zoom In/Out feature in increments of 50 miles can provide greater visual detail of equipment in a sweep
9 – Freeze improves visual detail by stopping the sweep of the arm for a site
RDVS pull down menus

Status/Recon  Maint Ops  View Misc  Utility Items  Quit

Status/Recon

- Summary Status
- 1) Positions (POSCOS 01-02)
- 2) Trunks
- 3) Radios
- 4) RTQC equipment and voice buses
- 5) Alarms
- Control Configuration

Maint Ops

- Fault Isolation
- Fault Description
- Clear/Ignore
- Recent Log Clear
- Update Status
- Alarm Reset

View Misc

- Log Archives
- Equipment Ids
- Show Raw Statuses
- Processor Report

Utility Items

- Save Log Archives
- Manual Log Entry
- Generate System

Quit (no further options)

This system runs on a DOS platform. The background color of the menu bar is blue, the content is in gray letters with the accelerator keys in white. As the pull down menus open their respective accelerator keys are also white (demonstrated with the letters and numbers that are not bolded). In the equipment room at the Atlanta TRACON these different menu bar items are chosen with the left and right arrow keys from the keyboard, and the up and down arrow keys permit selections from the pull down menus.
VSCS MPES pull down menus

SUMMARY STATUS SCREEN

Utilities Screens Reports Connect

Utilities
Logoff
Audible Alarm Control
Tape Management
Enable Remote Terminal
Disable Chatterlog
Reset System Time
Switch to Workstation Bus B
About Workstation

Screens
Summary Status
LU States
External Status
Current Fault List
Event List
Class 2 Event List
Outage List
Voice Channel Test
Workstation Bus LAN
Reconfiguration
AVP

Reports
Maintenance Log
Equipment Status
Current Fault List
Online Verification
AVP

Connect

Switchover (?)

VCE
A/G Frequency
G/G Trunk

Initiate LE
Status LE
Cancel LE
Multiple Start/Query
The Utilities, Screens, and Reports pull-down menus remain the same as from the Summary Status screen. From this screen, when **Connect** is chosen, a VCE Connectivity screen pops up over the main part of the page. This pop up provides information on the radar position location and the hardware associated with that position. The **Switchover** option also no longer opens a pull down. If Alt + w is chosen from this screen, the A/G switch changes from system A to B or B to A. The **Verify** item is used to make sure equipment that has failed is recovered (no pull down). **Determination** presents a detailed summary of a chosen position.

### VSCS MPES pull down menus (cont.)

#### LOGICAL UNIT STATUS SCREEN

<table>
<thead>
<tr>
<th>Utilities</th>
<th>Screens</th>
<th>Reports</th>
<th>Connect</th>
<th>Switchover</th>
<th>Start</th>
<th>Mode</th>
<th>Fail</th>
<th>Diagnose</th>
<th>Verify</th>
<th>Determination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate (LE)</td>
<td>Status (LE)</td>
<td>Cancel (LE)</td>
<td>Multiple Start/Query</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online Primary</td>
<td>Online Standby</td>
<td>Online Degraded</td>
<td>Offline Ready</td>
<td>Offline Failed</td>
<td>Offline Maintenance</td>
<td>Manual</td>
<td>Automatic</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A-23
VTABS pull down menus

- **System**
  - Login
  - Logout
  - Exit

- **Reconfiguration**
  - Position
  - Multiple Positions
  - Temporary
  - Logical to Physical
  - Assign
  - Unassign
  - Move
  - Custom

- **Status**
  - Reconfigure Process
  - Summary Screens

- **Definition**
  - Physical Resources
  - Logical Resources

- **Utilities**
  - Audible Alarms
  - Adjust Volume
  - Class 1 Alarms
  - Events
  - Event Details
  - Reports
  - Print
  - Print Setup
  - Save As
  - System Date/Time

- **Connectivity**
  - A/G Frequency
  - G/G Trunk
  - HUB
  - PEM

- **Window**
  - Cascade
  - Close All
  - Store User Profile
  - Restore User Profile
  - Summary Status
  - Reconfigure Process Status

- **Help**
  - About Workstation

- **Logical Positions**
  - Position Maps
  - Multiple Position Maps
  - Security Table
  - Preset Conference
  - Speed Dial Codes
  - Facility Setup
  - Meet-Me Conference
  - Multiple Site Radio Group
  - Number Plan
  - G/G Trunk Groups
  - Out Dial Tables
### WARP pull down menus

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Control</th>
<th>Animation</th>
<th>Overlay</th>
<th>View</th>
<th>Options</th>
<th>Windows</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALPHANUM Products Defs. Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Control</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Product Time to View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request Latest Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Oldest Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Previous Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Next Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Latest Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic Update</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audible Notification</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sequence</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reverse Play</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step Backward</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop Sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step Forward</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward Play</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Display Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DJcard Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quit Sequence</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status Bar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legend Bars</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thumbnail Title Bars</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size To Fit Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom &gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2x</td>
<td>4x</td>
<td>8x</td>
<td>16x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save State On Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore User State</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save User State Now</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore Default State</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save State As Default</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Windows</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Thumbnails</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Topics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Using Help</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>About Windows</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>